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HOW TO READ THIS GUIDE

The following table lists symbols used in this guide with descriptions and examples.

Symbol Description Example

Shows information you need to 
know.

The C Controller module executes program operation 
regardless of the switch status (RUN/STOP).

Shows reference manuals and  
pages on which you can find the 
details.

Refer to the following.

MELSEC-Q C Controller Module User's 

Manual

: SH-081130ENG

Shows the explanations of 
terminology.

Buffer memory: The memory of an intelligent function
                          module used to store data (such as
                              setting values and monitored values)
                          for communication with a C
                          Controller module

Shows descriptions that must be 
noted.

Power off the system before mounting a module.

[  ]
Menu names on the menu bar

([  ][  ] shows drop-down menus.)
Select [Project][New].

Buttons on the window  button

Keys on the keyboard  key

Point

Reference

Terminology

Caution

F4
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INTRODUCTION

This guide simply explains the basic operations of a C Controller module for the first-time users of the 

Mitsubishi programmable controller MELSEC-Q series C Controller module Q24DHCCPU-V (hereafter 

abbreviated as C Controller module).

This guide is targeted for users who use the MELSEC-Q series for the first time and are in the following 

situations:

• Users with experience in C language or C++ language programming

• Users considering to replace the microcomputer board or the personal computer system with a C 

Controller system

Reference

● Precautions

For safe use of the C Controller module, read "SAFETY PRECAUTIONS" in the C Controller

Module User's Manual.

Caution

This guide explains operations using the system configuration in "<2> System Configuration"

(P.15).

When designing/operating a system, refer to the manuals listed in the following.

"RELATED MANUALS"(P.12)
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Mounting and wiring modules

Checking operations

Creating programs

Quick Start 
Guide

All 
information is

included!

/* Open the bus.                                   
sRet = QBF_Open( CPU_TYPE, &lPath );
if( sRet != n ){
       :
/* Output control and dot matrix LED con
for( i = 0; i < 20; i++ ){
    /* Output control       
    sRet = QBF_Y_Out_WordEx( lPath, 
       :
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OPERATIONS THAT CAN BE PERFORMED 
USING C CONTROLLER MODULE

■ Sophisticated and high-speed processes and communications with the 
higher server

A C Controller module is a CPU module that supervises MELSEC-Q series modules and controls I/O 

devices using C language or C++ language program, and is used for the following:

    • Reuse a C language or C++ language program developed under a microcomputer board and

      personal computer environment.

    • Perform sophisticated and high-speed operation process, which is hard for ladder programs to

      handle, required in the fields such as manufacturing of semiconductor products and solar

     cells; and remote monitoring of public infrastructures (e.g. electricity, gas, and water systems).

The C Controller module easily achieves various functions using user programs.

Combined with partner products, the module can also perform the following functions.

    • Program-free SECS communication commonly used for semiconductor manufacturing and direct

      communication with the higher server without a gateway personal computer can be executed

      through a SECS communication software package.

    • In collaboration with a vision system, image distinction and product inspection can be performed

      without a personal computer.

A SECS 
communication

gateway is 
established,

saving cost and 
space.

Using the 
field network and 

the sensor network allows 
high-speed data collection 

with minimal wiring.

Operation/control

SECS communication 
(Ethernet)

Higher server

Data collection

Image distinction in collaboration 
with the vision system

Can be executed only 
with tool settings.

High-speed
synchronized

communications
with a servo amplifier 

is available.

Controller-to-controller
network in equipment

Machine
vision

Ethernet

Space-
saving and 

environmentally-
resistant
system

The high-speed 
(maximum 1Gbps) and 
large-capacity controller 

network reduces 
cycle time. Image

distinction and 
product inspection 
can be performed 
without a personal 

computer.

High-speed
operation process, 
which is hard for 

ladder programs to 
handle, can be 

performed.

The
development

cost is reduced by 
reusing C language 

program
resources.

Product image inspection

Semiconductor
manufacturing

Equipment controller (for 
data collection)

Motion network

Servo

Equipment controller (for 
transportation, loading/unloading)

Field network
Sensor
network
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■ Stable information processing ability and high real time property

1. Suppressing variations in user program execution for stable information 
processings
A C Controller module is equipped with two types of MPUs: an MPU for system control and an MPU for 

user program execution.

For this reason, a user program can be executed independently from the system control, and variations 

caused by a load state of the system control when a user program is executed can be minimized.

2. Various functions for real-time control
The C Controller module equips VxWorks (Wind River Systems, Inc.), real-time OS with many 

achievements and high reliability (The runtime license does not cost).

Since VxWorks supports a preemptive system*1, allowing real-time operation and sophisticated process 

that require an interrupt and punctuality, which may not be ensured under personal computer 

environment.

VxWorks also equips various functions, such as file access, drivers for the network functions, I/O and 

communication libraries, and therefore can be used for various purposes.

*1  A system that equally assigns execution time to multiple programs so that the processor (CPU) may

     not be dedicated to one program

MPU for 
I/O system 
control

MPU for MPU for 
user programuser program

Execute MELSEC-Q 
series module control

Execute data, 
communication, and 

numerical analysis processes
Execute user program 
without influencing

 system control overhead
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■ Features

1. Flexible system configuration using various MELSEC-Q series modules
In a C Controller system, program resources can be reused and various MELSEC-Q series modules are 

available, making system configuration easier.

So hard on 
 configuring 
  a system!

Microcomputer board and personal 
computer environment C Controller system

Power supply module

I/O 
module
High-speed 
input, interrupt 
input, AC/DC...
More than 
45 models

 High-reliable, long-

term, and stable supply

Discontinuation of boards/chips

Short product life cycle

Flexible system configuration using 
various MELSEC-Q series modules

Slotted 
in 

easily

Restrictions on hardware 

specifications and environment 

makes extension harder.

Available 

hardware limited

Troublesome installation/
removal work

Using extension base 

units makes extension easier.

Analog 
module
A/D conversion, 
D/A conversion, 
temperature 
control...More 
than 27 models

Network 
module
Controller-to-
controller 
network, wire-
saving system, 
sensor...More 
than 17 models

Positioning 
module
4 axes, 8 axes, 
16 axes, pulse 
input, differential 
output...More 
than 26 models

Other modules 
such as an 
information 
module
Logging, MES 
communication, 
serial communication
...More than 5 models

Base unit
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2. Equipped OS, drivers, and libraries allow you to focus on developing user 
programs
Since OS and communication drivers have been equipped with a C Controller module, you are no 

longer bothered with troublesome work under microcomputer board and personal computer 

environment (OS porting, driver development, OS writing to ROM) and can focus on developing a user 

program.

The C Controller module can easily access MELSEC-Q series modules using library functions 

dedicated for a C Controller module (bus interface function, MELSEC communication function).

Microcomputer board and personal 
computer environment

Easily manipulated using 

dedicated library functions.
Access to the modules is...

Analog
driver I/O

driver Network
driver

Network
board

I/O
board

Analog
board

C Controller system

User program

Library Library
Library

Analog
driver I/O

driver Network
driver

Library Library
Library

OS (must be changed
depending on system
configuration.)

User
program

All you need is to 

create a user program.

OS(VxWorks)

Already
equipped

Easy
Quick start

An OS must be created,and drivers and

libraries are required for each board.

Must be corrected whenever
the system is changed.

Much work
Troublesome

Write Y output data.

Y output
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3. Initialization, parameter settings, monitoring, and testing can be executed 
without a program
Complex programs for the initialization and the system settings of a C Controller module, and parameter 

settings of a network module are not required. The operations can be easily executed on view-friendly 

Setting/monitoring tool for C Controller module.

Programs to check module status, errors occurred in a C Controller module and in a user program, 

cable disconnection, and communication status are also not required.

int nRet;                                         // Fu
DWORD nLen;                              // Bi
ULONG ulBoardNo = 0;                // Bo

// Initialize the board numbered "0".
nRet = GpibOpen( ulBoardNo );
if (nRet) {
    printf("
    printf( : %d\n", n

Microcomputer board and personal 
computer environment C Controller system

Do I have to 
   create 
    programs all 
     over again?

Self-making

Ethernet

/* Md.31 Status information
printf("Status        [Md.31 ]");
printf("%7s0x%04hX%8s0x%04hX%8s0x

/* Specify the QD75M or the QD75MH.
if( (sType == UNITTYPE_QD75M) || (s
    /* Md.108 Servo status information
    printf("ServoStatus   [Md.108]"
    printf("%7s0x%04hX%8s0x%04hX%8s

Monitoring

Setting/monitoring  tool for 
C Controller module

Monitoring
Testing

Diagnostic/
error history

Monitoring and settings can be executed 
on the view-friendly tool.

ulSize      = (unsigned long)(PARAM
ulBufSize   = 0;
sRet=QBF_ToBuf( lPath, usIoNo / 16,
                ulSize, (unsigned s
                ulBufSize);

/* Judge writing.
if(sRet != 0){
    printf("Parameter area write er

Parameter settings
/* Md.31 Status information
printf("Status        [Md.31 ]");
printf("%7s0x%04hX%8s0x%04hX%8s0x

/* Specify the QD75M or the QD75MH.
if( (sType == UNITTYPE_QD75M) || (s
    /* Md.108 Servo status information
    printf("ServoStatus   [Md.108]"
    printf("%7s0x%04hX%8s0x%04hX%8s

Monitoring
int nRet;                                         // Fu
DWORD nLen;                              // Bi
ULONG ulBoardNo = 0;                // Bo

// Initialize the board numbered "0".
nRet = GpibOpen( ulBoardNo );
if (nRet) {
    printf("
    printf( : %d\n", n

Initialization Included
in one 

tool.Compilation

Program creation/correction

Download

Debugging

If an 
error or any 
correction is 

found, you must 
start all over 

again.

Initialization

A program 
is required for 
each operation.

Troublesome
steps

Parameter
settings

ulSize      = (unsigned long)(PARAM
ulBufSize   = 0;
sRet=QBF_ToBuf( lPath, usIoNo / 16,
                ulSize, (unsigned s
                ulBufSize);

/* Judge writing.
if(sRet != 0){
    printf("Parameter area write er

Parameter settings
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4. Quick start using an integrated development environment, "CW Workbench"
An engineering tool for C Controller, "CW Workbench", equips basic functions such as program editing, 

generation of execution module, and debugging. A user program for a C Controller module is easily 

developed.

Eclipse-based CW Workbench allows function enhancement using a third-party plug-in software.

Ethernet

CW Workbench

"Project Explorer" window

"Editor" window

"Remote Systems" window

"Breakpoints" window

"Debug" window

"Build Console" window

"Expressions" window

"Memory Browse" window

"Variables" window

"Registers" window

Project management and settings

Connection to the C Controller module

Display of build progress

Display of the current local variable value

Display of the current register value Display of the memory dump on
 the C Controller module

Display of the current variable value
 registered for viewing

Personal computer

Breakpoint management

Debugging

Program editing

The plug-in feature 
allows multilingualization of 

menu items and source 
code management.
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5.  Wide application using partner products
In combination with the following partner products, higher functionality and easy information link can be 

achieved.

(1) Collaboration with the vision system (COGNEX In-Sight EZ and In-Sight7000 series)

     Collaboration of the COGNEX machine vision with the C Controller module can easily automate

     manufacturing processes including measurement, inspection, and distinction of products.

Reference

For the detail of 3rd Party partner product, refer to the following.

iQ Platform C Controller:L(NA)08165E

HUB

In-Sight EZ series

By sending commands using a C language 
program, pictures and images can 
be imported.

Cognex Corporation

Collaborating with the integrated 
image processor, machine vision.

Ethernet
connection
available

In-Sight EZ-700
In-Sight 7000 series
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RELATED MANUALS

This guide explains the basic operations of a C Controller module.

To make maximum use of the C Controller module, refer to the following.

■ Learning about a C Controller module

■ Learning about CW Workbench

● MELSEC-Q C Controller Module User's Manual

...................................................................................................................................SH-081130ENG

This manual explains the system configuration, specifications, functions, handling, wiring 
troubleshooting, and programming and function of a C Controller module.

● Setting/Monitoring Tools for the C Controller Module Operating Manual

.....................................................................................................................................SH-081131ENG

This manual explains the system configuration and operation method of Setting/monitoring 
tools for the C Controller module.

● CW Workbench Operating Manual ............................................................................SH-080982ENG

This manual explains the system configuration, installation and uninstallation, specifications, 
functions, and troubleshooting of CW Workbench.
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USING C CONTROLLER MODULE

The C Controller module is installed with procedures as shown below.

<1> Preparing for Operation (P.14)
       Preparing the necessary devices

<2> System Configuration (P.15)
       Installing, wiring, and powering on the devices
       1) System configuration example (P.15)
             Showing the example of system configuration used in this guide
       2) Mounting the modules (P.16)
             Mounting the prepared modules on a base unit
       3) Wiring the modules (P.17)
             Wiring the power supply module and the output module
       4) Checking the power supply module (P.19)
             Powering on the system and checking module status

<3> Setting the Module (P.20)
       Configuring settings to operate the C Controller module using 
       Setting/monitoring tools for the C Controller module.
       1) Initializing the C Controller module (P.20)
             Preparing a standard RAM
       2) Setting parameters (P.22)
             Setting parameters for the C Controller module

<4> Knowledge Required for Programming (P.26)
       Explaining the bus interface function
       1) Dedicated Function Library (P.26)
       2) Dedicated functions used in this guide (P.27)

<5> Programming (P.29)
       Creating a program using CW Workbench
       1) Creating a project (P.32)
             Starting CW Workbench, creating projects, and configure settings
       2) Creating a user program (P.36)
             Creating a user program that controls a C Controller system.
       3) Generating an execution module from the user program (P.37)
             Converting (Building) the created program into an executable module
       4) Connecting a C Controller module to CW Workbench (P.38)
             Connecting a C Controller module to CW Workbench to perform debugging
       5) Debugging the user program (P.40)
             Checking operations of the created program
       6) Registering an execution module (P.44)
             Building the created program for operation and storing the program on the C 
             Controller module

<6> Checking Operations (P.46)
       Executing the program and checking operations
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<1> Preparing for Operation

Prepare the necessary devices.

*1  Install Setting/monitoring tools for the C Controller module(SW4PVC-CCPU) and CW Workbench on 
the same personal computer beforehand.

Reference

For installation of Setting/monitoring tools for the C Controller module, refer to the following.

Setting/Monitoring Tools for the C Controller Module Operating Manual: SH-081131ENG

For installation of CW Workbench, refer to the following.

CW Workbench Operating Manual: SH-080982ENG
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5) Ethernet cable

1) C Controller system 2) Personal computer

4) CW Workbench

Installation*1

Installation*1

For modules, refer to the 
next page.

Windows   -installed 
personal computer

Either a straight cable or 
a cross cable

3) Setting/monitoring tools 
for the C Controller 
module(SW4PVC-CCPU)
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<2> System Configuration

1) System configuration example

This guide uses the following system configuration as an example.

*A wire to the power supply module is omitted.

No. Name Model Description

1) Base unit Q33B
A unit on which a power supply 
module, a C Controller module, and 
I/O modules are mounted

2) Power supply module Q62P
Supplies power to modules such as 
a C Controller module and I/O 
modules.

3) C Controller module Q24DHCCPU-V
Supervises the control process of a 
C Controller system.

4) Output module QY40P
Connects with output devices. 
Lamps are connected in this 
example.

5)
Cable

(Ethernet cable)

An Ethernet cable meeting 10BASE-
T/100BASE-TX standards

Connects the personal computer 
with Setting/monitoring tools for the 
C Controller module and the C 
Controller module.

6)
Cable

(Ethernet cable)

An Ethernet cable meeting 10BASE-
T/100BASE-TX/1000BASE-T 
standards

Connects the personal computer 
with CW Workbench and the C 
Controller module.
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12VDC

QY40P

Lamps (output)C Controller system

1)

4)

2)

3)

5)

6)
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2) Mounting the modules

Mount the prepared modules on a base unit.

When using the C Controller module for the first time, connect a battery connector.

Caution

● Mount a battery before operation.

● Power off the system before mounting a module.

Point

● Mounting a battery to the C Controller module

Reference

For how to remove a module, refer to the following.

MELSEC-Q C Controller Module User's Manual: SH-081130ENG

C Controller module

Battery

Connect the battery connector to 
the connector pin on the case, 
checking the orientation

Check the battery is correctly 
installed.

Open the C controller module 
bottom cover.

Place the excess 
lead wire on the 
top of the battery.

Lead wire of 
the battery

Completed

Connector

Connector 
stopper

Module

Using the module fixing 
hole as a supporting point, 
push the module in the 
direction of arrow until it 
clicks.

Make sure that the module 
is inserted in the base unit 
securely.

Module 
mounting lever

Module fixing 
projection*1

Base unit

Module fixing  
hook*2

Base unit

Module connector
Module fixing hole

Module fixing  
projection

Base unit

Module 
mounting lever

Completed

Module fixing hole

Securely insert the module 
fixing projection*1 into the 
module fixing hole so that 
the latch is not misaligned.
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3) Wiring the modules

Wire the power supply module.

1. Wiring the power supply module

The following shows an example of wiring the power wire and the ground wire to the base unit.

Provide grounding to prevent electric shock and malfunction.

Caution

Power off the system before wiring the module.

Reference

For wiring precautions, refer to the following.

QCPU User's Manual (Hardware Design, Maintenance and Inspection): SH-080483ENG

ERR

2) FG

2) LG

1) INPUT

100-120VAC

1) Connect a 100VAC-

    power supply to the 

    power input 

    terminal.

2) Ground LG and 

    FG terminals.

Power supply module

(Q62P)

Ground 

wire
Grounding

100VAC

AC
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2. Wiring the output module

The following shows an example of wiring the output module (QY40P).

Point

Wire the power supply line of the output device and that of the C Controller system

separately as shown below.

+

-

L

Lamp 1
Signal: Y00

L

Lamp 2
Signal: Y01

100VAC

200VAC

Main 

power 

supply

Relay 

terminal 

block

Power supply of

the C Controller

system

C Controller 

system

Output device

Insulation 

transformer

Inside of a control panel

Output power supply

T1
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4) Checking the power supply module

Check that the power supply module runs normally after installing the system, mounting the modules, 
and wiring the system.

Operating procedure

1. Check the following before powering on the system.
• Wiring to the power supply module
• Power supply voltage 

2. Set the C Controller module to STOP.

3. Power on the power supply module.

4. Check that the power supply module runs normally.

Open the cover on the front of the C Controller

module and set the "RUN/STOP/MODE" switch to

"STOP".

Check the front LED on each module.

The following lists the normal status of the LEDs.

  1) Power supply module: The "POWER" LED lights in

      green.

  2) C Controller module: The "MODE" LED lights in

      green.

  3) C Controller module: The "U RDY" LED lights after

      flashing in green.

     Then, initialize the module.

"<3> Setting the Module" (P.20)

Construction of the system is ended.

Point

If the "POWER" LED of the power supply module remains off even after power-on, check that

the power supply module is correctly wired and mounted.

Reference

If the "ERR." LED turns on or starts flashing, troubleshoot with reference to the following.

MELSEC-Q C Controller Module User's Manual: SH-081130ENG

"RUN/STOP/MODE" switch

3)

2)1)
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<3> Setting the Module

Configure settings to operate the C Controller module.

1) Initializing the C Controller module

Operating procedure

1) Open the cover on the module front and set the
"RESET/SELECT" switch to "RESET".

2) Check that the LED is off.

3) Holding the "RUN/STOP/MODE" switch on the
"MODE" position, set the "RESET/SELECT" switch
to the center.

4) Check that the "MODE" LED lights in "orange", and
the dot matrix LED displays "M-00".

5) Release the "RUN/STOP/MODE" switch.
The switch returns to the "STOP" position.

6) Repeatedly set the "RESET/SELECT" switch to
"SELECT" until the dot matrix LED displays "0011"
("module initialization setting" mode). 

7) Set the "RUN/STOP/MODE" switch to "RUN" and
initialize the module. The "RUN" LED will be
flashing during initialization.

Caution

Initialization deletes data in the C Controller module.

Before you can perform the initialization, back up all necessary data, user programs and

parameters.
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8) Check that the "RUN" LED turns off, and the dot
matrix LED displays "0000". Reset the C Controller
module.

9) Resetting the C Controller module will initialize the
module.
The "RUN" LED and the "USER" LED start flashing
in green.

10) When the initialization is completed, the "RUN"
LED and the "USER" LED end flashing, and the
"MODE" LED starts flashing in green.

11) Reset the C Controller module.
When the initialization is completed, the "RUN"
LED, the "MODE" LED, and "U RDY" LED light in
green.

Point

Resetting procedure

1) Set the "RESET/SELECT" switch on the front of the C 
    Controller module to "RESET".

2) Check that the "MODE" LED 
     turns off.

[Reset end status]

3) Set the "RESET/SELECT" switch 
    to the center.

Caution

Do not operate the switches using a sharp-pointed tool such as a driver. 

Doing so may damage the switches.
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2) Setting parameters

Set parameters for the C Controller module.

1. Connecting a C Controller module to a personal computer

Connect the system Ethernet port(S CH1) of the C Controller module to a personal computer using an 
Ethernet cable.

Terminology

Parameter: Setting data required for a C Controller system to operate.

Set modules and a network in a C Controller system using Setting/monitoring tools

for the C Controller module.

Caution

The IP address of the C Controller module and that of the personal computer must be set to

the same segment.

Since this guide uses the default IP address for the C Controller module's system Ethernet

port(S CH1) (192.168.3.39), set the IP address for the personal computer to "192.168.3.* (*:

other than 0, 3, 39, and 255)".

Set the subnet mask for the personal computer to "255.255.255.0".

Reference

For how to change an IP address, refer to the following.

MELSEC-Q C Controller Module User's Manual: SH-081130ENG

0
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4

5

6

7

8

9

A

B

C

D

E

F

COM

24VDC
0 . 1A

12VDC

QY40P

Personal computer C Controller 
module
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2. Create a parameter on the personal computer

Operating procedure

1)Start up the Setting/monitoring tools for the C Controller module.

Select [Start]→[All Programs]→[MELSEC]→[C Controller module Ver.4]→[Setting/monitoring tools for 
the C Controller module].

2)Create a project.

[Project]→[New].

3)Set the CCPU Parameter.

Project view →"Parameter" →"CCPU Parameter" →<<I/O assignment settings>>.

Point

For Setting/monitoring tools for the C Controller module Version 4.02C or later, select

"Q24DHC-V" for the CPU type.

Reference

For each setting screen and setting item, refer to the following.

Setting/Monitoring Tools for the C Controller Module Operating Manual

: SH-081131ENG
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3. Writing the parameters to the C Controller module

1)Set the C Controller module for the connection destination.

Select Navigation window →Connection Destination view →"(connection destination data name)".

2)Write the parameters.

[Online] →[Write to CCPU]

Click  button →Click   button
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4. Reset the C Controller system.

The written parameters are applied.

Point

When the account input screen appears, enter the following:

User name: target

Password: password
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<4> Knowledge Required for Programming

1) Dedicated Function Library

The dedicated function library is a function implemented in a C Controller module as standard.The 
following functions are available for controlling each module and reading the operating status.

1. Bus interface functions
          (1) Opening/closing a bus

To use the functions, open a bus at the start of the program and close the bus at the end of the program.

Functions to open/close a bus

          (2) I/O access

1-point access and 1-word access are available.

1) 1-point access: A function that treats 1-point data (ON/OFF of switches and lamps)

    Example of 1-point access functions

2) 1-word access: A function that treats 1-word (16 bits) data (numeric values, characters)

    Example of 1-word access functions

●Bus interface functions
This function controls I/O modules and intelligent function modules via a bus of a base unit.

●C Controller Module Dedicated Function
This function controls the operating status and the indicator LED of a C Controller module.

Name Function

QBF_Open Opens a bus.

QBF_Close Closes a bus.

Point

Open or close a bus (QBF_Open/QBF_Close functions) once at the start of a program and at

the end of a program, respectively.

By using these functions only once, communication performance will be improved.

Name Function

QBF_X_In_BitEx Reads an input signal (X) in units of one point.

QBF_Y_Out_BitEx Outputs an output signal (Y) in units of one point.

QBF_Y_In_Bit_Ex Reads an output signal (Y) in units of one point.

Name Function

QBF_X_In_WordEx Reads an input signal (X) in units of words.

QBF_Y_Out_WordEx Outputs an output signal (Y) in units of words.

QBF_Y_In_WordEx Reads an output signal (Y) in units of words.
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2. C Controller Module Dedicated Function
   (1) User LED control

 Indicator LED control and the dot matrix LED control are available.

 Example of user LED control functions

2) Dedicated functions used in this guide

Dedicated functions of output access and the dot matrix LED control, are used in the program created 
in this guide.

   • Opening a bus: QBF_Open functions

• Closing a bus: QBF_Close functions

Name Function

CCPU_SetLEDStatus Controls Indicator LED of a C Controller module.

CCPU_SetDotMatrixLED Controls the dot matrix LED of a C Controller module.

Reference

Only the basic bus interface functions are explained in this section.

The MELSEC communication function used for reading/writing of devices via a network are

also available.

For details of the dedicated function library, refer to the following.

Setting/monitoring tools for the C Controller module→[Help]→[Function help]→[C 

Controller module function help]

Type Argument Name Function IN/OUT

short sUnit Module 
identification

Specify the module.

(2: C controller module)

IN

long* plPath Path of bus Stores the pointer to the path of the 
opened module.

OUT

Type Argument Name Function IN/OUT

long lPath Path of bus Specifies the path of the opened bus. IN
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   • Output access: QBF_Y_Out_WordEx function

   • Dot matrix LED control: CCPU_SetDotMatrix LED function

Type Argument Name Function IN/OUT

long lPath Path of bus Specifies the path of the opened bus. IN

short sFlg Access flag Specifies an access flag.

(0: Normal access, other than 0: 
Reserved)

IN

unsigned short usYNo Start output number Specifies a start output number (Y).

(Specify a multiple of 16.)

IN

unsigned short usSize Output size Specifies the output data size in 1-
word units.

IN

unsigned short* pusDataBuf Data storage 
destination

Specifies the storage destination of 
output data.

IN

unsigned short usBufSize Size of data storage 
destination

Specifies 0. (dummy) IN

Type Argument Name Function IN/OUT

unsigned short usLedMode Output mode Specifies the output mode for the dot 
matrix LED.

When Reserved is specified, this 
function completes normally without 
processing.

(0: Dot mode, 1: ASCII mode, Others: 
Reserved)

IN

char* pcData LED data Specifies the LED data. IN

Reference

The following data types are available for C language and C++ language programming used

on a C Controller module.

Data type Bit width Designation

byte 8 Unsigned integer

char 8 Character string

unsigned char 8 Unsigned character string

short 16 Signed short integer

unsigned short 16 Unsigned short integer

int 32
Signed (long) integer

long 32

unsigned long 32 Unsigned (long) integer

float 32 Single-precision real number

double 64 Double-precision real number

void - -
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<5> Programming

Create a program in which lamps connected to an output module and the dot matrix LED on the front of 
the C Controller module flash.

1. Program example and control description

Create a program that performs the following control.

When the C Controller module is set to RUN, output lamps Y00 and Y01 alternately turn on.
Synchronizing with the on status of the output lamps, the tens place and ones place of the dot matrix 
LED alternately turn on.

QY40P
0 1 2 3 4 5 6 7
8 9 A B C D E F

F
E
D
C
B
A
9
8
7
6
5
4
3
2

1
0

0

1

2

3

4

5

6

7

8

9

A

B

C

D

E

F

COM

24VDC
0 . 1A

12VDC

Y20

Y21

Y20

Y21

Output access

dot matrix LED control

/* Perform an output control and dot matrix LED control in turns by 20 times.                                            */

for(i = 0; i < 20; i++){

    /* Output control                                                                                                                                       */

        sRet = QBF_Y_Out_WordEx(lPath, NORMAL_ACCESS, UNIT_XY, WORD, &usDataBuf, DUMMY);

       if(sRet != 0){

            printf("ERROR : QBF_Y_Out_WordEx_1 [%d(%04hxH)]\n", sRet, sRet);

            QBF_Close(lPath);

            return;

        }

    /* dot matrix LED control                                                                                                                          */

        sRet = CCPU_SetDotMatrixLED(MODE_ASCII, &pcdata[0]);

       if(sRet != 0){

Alternately turns on.Alternately turns on.
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2. Source code

The following describes source codes.

Control the output 
module using the bus 
interface function.

Control the dot matrix 
LED using the bus 
interface function.

Enable the bus 
interface function at the 
start of the program.

Declare the file that 
defined a function 
list for use of the 
library function.

Define values used 
for the control.
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Disable the bus 
interface function at 
the end of the program.

Turn off both outputs 
from the output module 
and the dot matrix LED.
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1) Creating a project

1. Starting CW Workbench

Operating procedure

1) Select [start][All Programs][Wind River][CW 
Workbench][CW Workbench].

2) Enter the storage location of the workspace.
In this procedure, enter "C:\WindRiver\workspace".

3) Click the  button.

4) Click the  button.

The main window of CW Workbench appears.

②

③

④

Reference

• The default window sizes and icon

  positions on CW Workbench depends on

  a personal computer. If a window size

  differs from that shown in this guide,

  adjust the size.

• To default an enlarged/deleted window,

  select [Window][New Window].
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2. Creating a project

Operating procedure

1) Select [File][New][Wind River Workbench
Project...].

2) Select "Wind River VxWorks6.8".

3) Click the  button.

4) Select "Downloadable Kernel Module".

5) Click the  button.

6) Enter a project name.
In this procedure, enter "Q24_SampleProject".

7) Click the  button.

The project has been created.

①

②

③

④

⑤

⑥

⑦
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3. Creating a project property

Configure settings to convert (build) the created project into a module that can be executed on a C 
Controller module.

(1) Setting the processor

1) Select the created project in the "Project Explorer" 
window, and click [Project][Properties].

2) Select "Build Properties" from the tree view to the left 
in the window.

3) Click the "Build Support and Specs" tab.

4) Select the "PENTIUM4gnu" check box only in 
"Available and enabled build specs:".

5) Select the "Debug mode" check box.

(2) Setting a include file

1) Click the "Build Paths" tab.

2) Click the  button.

3) Click the  button.

Terminology

Build: An operation that compiles source codes according to a processor and links the code to

 the include file.

Point

Clear the "Debug mode" check box for the 

actual system operation.

①

② ③

④

⑤

②

①

③
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4) Select the include folder dedicated for the C 
Controller module in the "Select directory" window.

In this procedure, the folder is the one when 
Setting/monitoring tools for the C Controller module 
has been installed on "C:\MELSEC".

5) Click the  button.

6) Check that the folder specified in the "Add include 
search path to selected build spec" window has 
been selected.

7) Click the  button.

8) Check that the added include path is displayed in the 
"Include paths:" area.

9) Click the  button.

10) If the following message appears after clicking the 

 button, click the  button.

The project property has been set.

④

⑤

⑥

⑦

⑧

⑨

⑩



36

2) Creating a user program

Create a user program that controls a C Controller system.

Operating procedure

1) Right-click the created project in the "Project 
Explorer" window, and click [New][File].

2) Enter a source file name to be created in "File 
name:".
Enter "Q24_Sample.c" in this procedure.

3) Click the button.

4) Describe "Source code"(P.30) to access the output 
module and to control the dot matrix LED in the 
"Editor" window.

Point

Enter a file name with extension.

Do not use two-byte characters for a file 

name. If used, a compilation error occurs in 

compilation.

①

②

③
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3) Generating an execution module from the user program

Convert (Build) the created program into a module that can be executed on a C Controller module.

Operating procedure

1) Right-click the created project in the "Project 
Explorer" window, and click [Rebuild Project].

2) If the message shown below appears, click the 

 button.

The project starts to be built. The progress is
displayed in the "Build Console" window.

3) Check that "Build Finished..." is displayed in the 
"Build Console" window.

"Build Finished..." indicates the completion of
creation and build of the user program.

Point

If "Build Finished..." is not displayed and an 

error occurs, check the error and correct 

the program.

After the correction, perform the  operation 

again from "3) Generating an execution 

module from the user program"(P.37).

①

②

③



38

4) Connecting a C Controller module to CW Workbench

Connect the user Ethernet port CH1 of a C Controller module to CW Workbench to perform debugging 
using CW Workbench.

Operating procedure

1) To acquire a VxWorks image file from the C 
Controller module, start Explorer and enter the 
following address in the address area.

ftp://192.168.3.3/SYSTEMROM/OS_IMAGEFILE/

The "Log On As" window appears.

2) Enter the following user name and password in the 
"Log On As" window.

• User name : target

• Password : password

3) Click the  button.

4) Copy the VxWorks image file stored on the C 
Controller module to 
"C:\MELSEC\CCPU4\CCPUTool".

5) Click  in the "Remote Systems" window.

The "New Connection" window appears.

6) Select "Wind River VxWorks 6.x Target Server 
Connection" in the "New Connection" window.

7) Click the  button.

Point

To communicate between the C Controller 

module and the personal computer, specify 

the  same VxWorks image file for both.

①

②

③

④

Point

The "C:\MELSEC\CCPU4\CCPUTool" 

folder is created when Setting/monitoring 

tools for the C Controller module has been 

installed on "C:\MELSEC".

⑤

⑥

⑦
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8) Set the following items in "Backend settings".

• Backend  : wdbrpc

• Processor  : Z5xx (Click the 

                          button and select the processor.)

• IP address : 192.168.3.3 (default)

• Port  : Blank

9) Select the "File" radio button in "Kernel image".

10)Click the  button.

The "Open File" window appears.

11)Select the VxWorks image file copied in the step 4) 
(C:\MELSEC\CCPU4\CCPUTool) from the tree 

view, and click the  button.

12)Click the  button.

13)Select the target server added in the "Remote 

Systems" window, and click .

14)After  is clicked, the connection is completed 

when "connected - target server running" is 
displayed at the bottom of the "Remote Systems" 
window.

⑧

⑨ ⑩

⑪

Point

If "connected - target server running" is not 

displayed, check that the C Controller 

module is normally powered on, and 

perform the operation again from "4) 

Connecting a C Controller module to CW 

Workbench"(P.38).

⑫

⑬

⑭
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5) Debugging the user program

Check that the created program correctly operates.

1. Downloading the user program on the C Controller module

To debug the user program, download the execution module on the memory in the C Controller module.

Downloading a user program allows users to execute the program without a script file.

1) Right-click the created module file 
"Q24_SampleProject.out" in the "Project Explorer" 
window, and click [Download VxWorks Kernel 
Task].

The "Download Configurations" window appears.

2) Select the "VxWorks6x_192.168.3.3 (Wind River 
VxWorks 6.8)" check box only in "Launch Context:".

3) Click the  button.

Terminology

Script file: A file that describes the download location and the startup procedure of the user

                 program that starts at the start of a C Controller module

①

Point

The "Launch Configuration Selection" 

window appears on and after the second 

operation of the step 2).

Select the "Launch the selected launch 

configuration" radio button and click the 

 button.

②

③
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2.  Debugging the user program
1) Select the created project in the "Project Explorer" 

window, and click  on the right side of  on the 

toolbar.

2) Click [Debug Configurations...].

The "Debug Configurations" window appears.

3) Click the downloaded module 
"Q24_SampleProject.out" from "VxWorks Kernel 
Task".

4) Select the target server indicating connection to the 
C Controller module.

5) Click the  button.

The "Entry Points" window appears.

6) Select the function that starts debugging 
(Q24_SampleTask).

7) Click the  button.

8) Check that the function name selected in the step 
6) has been selected in "Entry Point:".

9) Click the  button.

10)Debugging starts. Program execution stops at the 
start of the function specified in "Entry Point:".

②

①

③

④

⑤

⑥

⑦

⑧

⑨

⑩
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11)Click  in the "Debug" window to perform 

debugging by one step.

12)By clicking a tab on the bottom right of the 

"Variables" window*1. variable values can be 
checked and changed.
In this step, check that "sRet", return value of the 
"QBF_Open" function, is "0" (normal value).

*1  Depending on a personal computer, the "Variables" 
window appears as shown below. Adjust the 
window size.

In the steps 11) and 12), debug the entire program.

⑪

⑫

Reference

If the return value of the bus interface 

function and C Controller Module 

dedicated function is other than "0", 

troubleshoot with reference to the 

following.

Setting/monitoring tools for the C 
Controller module→[Help]→[Function 
help]→[C Controller module function 
help]

MELSEC-Q C Controller Module User's 
Manual: SH-081130ENG



43

<Debugging using breakpoint>

As well as debugging in units of one step 
described in the step 11) , 

debugging using a breakpoint is available.

1) Double-click the left edge of a source file window 
and insert a breakpoint.

2) Click .

The program is executed at the position specified
by the breakpoint.

13)Click  in the "Debug" window to terminate the 

debugging session. 

①

②

Reference

The descriptions of icons are as follows:

 : Step Into

        Steps into the called function and

         stops at the first line of the function.

 : Step Over

        Executes the current line of the 

          function and then stops at the next line

        of the function.

 : Continues execution until the current

         function has returned to its caller.

 : Executes a program.

 : Stops a program.

 : Ends debugging.

Point

To start debugging again, click  on the 

right side of  on the toolbar and select 

the created debug configuration at the top 

of the pop-up menu.

The steps 1) to 10) can be skipped.

⑬
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6) Registering an execution module

Build the created program for operation and store the created module on the C Controller module.

Operating procedure

1.  Building the user program
1) Select the created project in the "Project Explorer" 

window, and click [Project][Properties].

2) Select "Build Properties" from the tree view to the 
left in the window.

3) Clear the "Debug mode" check box.

4) Click the  button.

5) Build the program following the procedure shown in 
"3) Generating an execution module from the user 
program"(P.37).

6) If the following message appears, click the 

 button.

2.  Storing the user program
1) Start Explorer and enter the following address in 

the address area for the C Controller module.

ftp://192.168.3.3/ROM

After login to the C Controller module, the address
is displayed as shown below.

2) Copy the created user program 
"Q24_SampleProject.out" on the standard ROM for 
the C Controller module by drag and drop.
The user program created in this guide is stored on 
the following:

C:\WindRiver\workspace\Q24_SampleProject\PE
NTIUM4gnu\Q24_SampleProject\NonDebug

①

②

③

④

⑥

①

②
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3.  Creating and storing a script file
Create a script file that automatically downloads the
execution module at the start of the C Controller
module.

1) Open a text file and describe a script file that 
downloads the user program and generates the 
task as shown below.

2) Name the file as "STARTUP.CMD" and save the 
file.

3) Copy the created script file on the standard ROM of 
the C Controller module.

ftp://192.168.3.3/ROM

The script file has been created and stored.

Point

A user program and a script file can be 

stored on the SD memory card as well.

When a script file is stored both the 

standard ROM and the SD memory card, 

one on the SD memory card is started by 

priority.

The "Q24_SampleProject.out" 
file is loaded from the 

standard ROM.

The "Q24_SampleTask" function 
is generated under 

the default task name (t1).

③
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<6> Checking Operations

Execute the program registered with the C Controller module and check operations.

Use the "RUN/STOP/MODE" and "RESET/SELECT" switches on the front of the C Controller module.

[Functions of the "RUN/STOP/MODE" switch]

 • RUN : Enables outputs (Y) and writing to the buffer memory from a user program 
 • STOP : Disables outputs (Y) and writing to the buffer memory from a user program
 • MODE : Used for the hardware self-diagnostic function

[Functions of the "RESET/SELECT" switch]

 • RESET : Resets hardware and programs.
 • SELECT : Used for the hardware self-diagnostic function

Point

The C Controller module executes program operation regardless of the switch status (RUN/

STOP).

Reference

For details on the "RUN/STOP/MODE" and "RESET/SELECT" switches, refer to the following.

MELSEC-Q C Controller Module User's Manual: SH-081130ENG
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Operating procedure

1. Enable outputs (Y) from the user program.

2. Reset the C Controller module.

Point

To disable outputs (Y) from the user program, set the "RUN/STOP/MODE" switch to "STOP".

Reference

If the "ERR." LED turns on or starts flashing, troubleshoot with reference to the following.

MELSEC-Q C Controller Module User's Manual: SH-081130ENG

"RUN/STOP/MODE" switch

MODE: Lights in green.
RUN   : OFF

MODE: Lights in green.
RUN   : Lights in green.

1) Set the "RUN/STOP/MODE" switch on the front of the C Controller module to "RUN

2) When the "RUN" LED lights in green, the program is running normally.

LED display during the STOP status 

LED display during the RUN status 

"RESET/SELECT" switch

"RESET/SELECT" switch

MODE: Lights in green.

MODE: OFF

1) Set the "RESET/SELECT" switch on the front of the C Controller module 
    to "RESET".

2) Check that the "MODE" LED turns off.

[During reset] 

[Reset completed] 

3) Set the "RESET/SELECT" switch to the center.
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3. Use the dot matrix LED and lamps to check operations.

The dot matrix LED on the front of the C Controller module and output lamps operate as follows: 

1) The tens place and ones place of the dot matrix LED alternately turn on by 20 times.

2) Synchronizing with the dot matrix LED, output lamps Y20 and Y21 alternately turn on.

3) To check the operations again, reset the C Controller module.

Reference

Status of the dot matrix LED and the output lamps also can be checked on Setting/monitoring

tools for the C Controller module. ((P.49),(P.52))
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FREQUENTLY-USED FUNCTIONS

This chapter describes functions frequently used for the start-up and the maintenance after operation of 

a C Controller system.

<1> Checking Errors

An error can be checked and the corrective action can be taken using Setting/monitoring tools for the C 
Controller module.

1) How to check an error

Operating procedure

1) Select [Diagnostics] →[CCPU diagnostics] in 
Setting/monitoring tools for the C Controller 
module.

2) The C Controller module diagnostic screen 
appears

3) An error code is displayed in the window.

4) The check boxes of the current errors color in red 

( ).

The error code is kept updated during monitoring.
①

③

④
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2) Checking error history

Errors occurred up to the present and the error details can be checked.
When and what kind of error occurs can be checked, useful in error analysis.

Operating procedure

1) Start up Setting/monitoring tools for the C 
Controller module.

2) Select [Diagnostics]→[Event history].

3) Error history and the error details are displayed.

4) To see more details of an error, double-click the 
error.

The "Detailed event information" window appears.

5) Clicking the  or the  button 

will display the details of the previous or the 
following error.

6) Clicking the  button will open the help 

window on the error.

②

③

④

⑤

⑥
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<2> Monitoring Module Status and Testing Operations

Module I/O status and buffer memory status can be checked through Setting/monitoring tools for the C 
Controller module. I/O status can be checked and operations can be tested at start-up and maintenance.

1) Checking module I/O status and buffer memory status

The input (X) and output (Y) status of the module and buffer memory status can be monitored.

Operating procedure

1. Select [Online]→[Device monitor] of Setting/monitoring tools for the C Controller 
module.

The "Device monitoring" window appears.

Terminology

Buffer memory: The memory of an intelligent function module (module such as A/D conversion

module and D/A conversion module having a function other than input and

output) used to store data (such as setting values and monitored values) for

communication with a C Controller module



52

2. Check the "Device monitoring" window.

No. Name Description

1) Device Enter the device name.

2) Monitor format

Set the monitor format.

Bit & Word: Set the monitor screen to the bit and word display.

Bit: Set the monitor screen to the bit display only.

Word: Set the monitor screen to the word display only.

3) Display
Set the display format of the device values to be displayed when the monitor format is 
"Bit & Word" or "Word".

4) Data format
Set the radix (decimal/hexadecimal) when the display format is "16 bit integer" or "32 
bit integer".

5) Bit order

Set the order in which the bit devices being monitored are arranged.

F-0: Arranged in order of F, E, ... 1, 0 from left to right.

0-F: Arranged in order of 0, 1, ... E, F from left to right.

①

②

③

④
⑤
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2) Testing operations by forced output

Module operations can be tested by forced output from an output (Y).
The following describes the procedure for forced output.

1. Click the  button in the "Write to Device" screen.

2. Forced output from an output (Y) is executed.

Point

An operation test by forced write to a buffer memory can be executed in the same manner.
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Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United 
States and/or other countries.

Ethernet is a registered trademark of Fuji Xerox Co., Ltd. in Japan.

The SD and SDHC logos are trademarks of SD-3C, LLC.

VxWorks is either registered trademarks or trademarks of WindRiver Systems, Inc.

The company names, system names and product names mentioned in 
this manual are either registered trademarks or trademarks of their respective companies.

In some cases, trademark symbols such as '™' or '®' are not specified 
in this manual.
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